2 Getting started with Maple's Document Mode: doing technical work with a clickable interface

2.1 Chapter synopsis

1. How to start up Maple and perform simple calculations, algebra, and plots within it.
2. Detecting and fixing typographical mistakes.
3. Introducing mistakes caused by vocabulary misunderstandings and the use of incorrect logic in giving directions.
2. How to save Maple work so that you can refer to it or resume working on it later.
3. How to recover a Maple worksheet if it or your computer crashes.

2.2 Starting up Maple, getting a fresh start

Start up the Maple application (this varies on the type of computer system you have, typically it involves clicking or double-clicking on the Maple 13 icon, but if you can't figure it out yourself ask for a demo for someone who knows). Once the Maple application window appears, a new "document" will appear in the main working area of the Maple application. A flashing cursor will appear with the outline of a small rectangle with dashed lines. The entry mode will read "Math" and "2D Math". You can make the "quick help" black box disappear by clicking on the "close box" circle-X in the upper right hand corner.

Table 2.1: Maple started up with new document in Windows XP

![Maple application window](image)
After you close the quick help box, you will see the Maple cursor in a small rectangle with a dashed line outline

Table 2.2: Maple document with first entry area

At this point, what you type will appear in the small rectangle and be regarded as a mathematical expression. In the next section, we describe what to type in order to get something useful to happen.
2.3 Evaluating an expression involving exact arithmetic

Grade school arithmetic

In the math area, type 2 + 3. "2 + 3" is regarded as a mathematical expression by Maple when you type it into the dashed rectangle. As you are typing, the input indicators should say that you are entering Math mode, in "2D Math" input, using "Times New Roman" font:

Table 2.3: Maple input using 2d math

![Maple input using 2d math](image)

This expression should show up in the work area. When you hit the enter key, then Maple will evaluate the expression. After the expression is evaluate, you should see the result displayed below the input, as in the figure below:

Table 2.4: Maple input with labeled result

![Maple input with labeled result](image)

Maple has automatically calculated the answer and given it a label (1). After Maple calculates the answer, the cursor should appear below the result in another dashed-line rectangle. This indicates that Maple is ready to do another calculation.

Maple supports all the basic arithmetic operations in a fashion similar to many other programming languages. One thing that takes some getting used to is that * (asterisk) is used to input multiplication rather than "x" or a centered dot. Another thing that takes some getting used to is that what you type is formatted to look like math notation. Thus if you type a /, Maple understands that you are talking about division and immediately starts formatting your input as if it were a fraction. If you type an asterisk, Maple formats that into a dot (.). There is also formatting that occurs with caret (^) since that is the way you enter an exponent in Maple.
Table 2.5: Arithmetic Operations in Maple

<table>
<thead>
<tr>
<th>Operation</th>
<th>Character to type/ character name</th>
<th>Notes</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>addition</td>
<td>+ (&quot;plus&quot;)</td>
<td></td>
<td>2 + 2</td>
</tr>
<tr>
<td>multiplication</td>
<td>* (&quot;asterisk&quot;)</td>
<td>Typing an asterisk makes a center dot (·) appear in the displayed expression.</td>
<td>2·3</td>
</tr>
<tr>
<td>division</td>
<td>/ (&quot;slash&quot;)</td>
<td>Typing a slash draws a baseline and then positions the cursor in the denominator. Subsequent typing appears in the denominator. To get out of the denominator and return to normal typing, use the right-arrow key (→). Multiple divisions are by default conducted left-to-right.</td>
<td>( \frac{2}{6} )</td>
</tr>
<tr>
<td>subtraction</td>
<td>- (&quot;dash&quot; or &quot;hyphen&quot;, typically on the same keyboard key as the underscore. Dash and underscore do not mean the same thing.)</td>
<td>Multiple subtractions are conducted leftmost first.</td>
<td>3 − 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 − 5 − 7</td>
</tr>
<tr>
<td>parentheses</td>
<td>( , ) (&quot;left parenthesis&quot;, &quot;right parenthesis&quot;)</td>
<td>Use parentheses to change the order of calculation. They are also good for removing any guesswork by the reader as the order of operations.</td>
<td>((2 + 3) \cdot 5)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 − ( \left( 5 - \frac{2}{6} \right) )</td>
</tr>
<tr>
<td>negation</td>
<td>- (&quot;dash&quot; or &quot;hyphen&quot;, typically on the same keyboard key as the underscore). This is the same symbol as used for subtraction.</td>
<td>Put a dash in front of a number or parenthesized expression to negate it.</td>
<td>−(3·5 − 2)</td>
</tr>
<tr>
<td>power</td>
<td>^ (&quot;caret&quot;, typically on the same keyboard key as the number 6)</td>
<td>Typing a caret moves the cursor to the exponent position. Subsequent typing appears in the exponent. To get out of the exponent and return to the baseline, use the right-arrow key (→).</td>
<td>(2^3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(2^3 - 5)</td>
</tr>
<tr>
<td>factorial</td>
<td>$n!$ is the product of all the integers between 1 and $n$. It is useful in computations that compute the number of possible ways that something could happen. For example, the number of possible orderings of a deck of playing cards is $52!$</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>$2^2$</td>
<td>$\sqrt{2}$</td>
<td>(2.12)</td>
<td></td>
</tr>
<tr>
<td>$2^{-2} + \frac{4}{5}$</td>
<td>$\frac{21}{20}$</td>
<td>(2.13)</td>
<td></td>
</tr>
<tr>
<td>$4!$</td>
<td>$24$</td>
<td>(2.14)</td>
<td></td>
</tr>
<tr>
<td>$(3!)!$</td>
<td>$720$</td>
<td>(2.15)</td>
<td></td>
</tr>
<tr>
<td>$52!$</td>
<td>$8065817517094387857166063685\times6403766975289505440883277\times82400000000000$</td>
<td>(2.16)</td>
<td></td>
</tr>
</tbody>
</table>

Let's try out some of these operations. We can enter a sum of two fractions by using "+" and "/". If we type "2/3→+5/6 enter", this is what we see:

$$\frac{2}{3} + \frac{5}{6} = \frac{3}{2}$$

(2.17)

The way to get a fraction in is to type a slash (/). As soon as you do so, Maple draws an underscore and positions the cursor underneath the fraction line. The next characters you type appear as the denominator. If you type the "+" right after the "3", the plus will appear in the denominator which is permitted by Maple but not what we want in this situation. To get the plus to appear outside of the fraction, we type the right arrow key (the key with → on it). This moves the cursor out of the fraction back into the baseline of the expression. Then we can enter the + for addition, and another fraction. After we hit the enter key, Maple will simplify the result into a single fraction with any common factors removed from the numerator and denominator.

Now let's do a multiplication. The Maple programming language (like most) uses an asterisk * as the symbol for multiplication. However, Maple displays the expression with a centered dot. This may be disconcerting -- what you type is not what you see. When you are in "math mode" Maple will be using fancy typography to display whatever math you are entering. We'll see more of this shortly. See if you can reproduce this result:

$$2\cdot3 = 6$$

(2.18)
We can mix operations. Try to enter and calculate the following:

\[
\frac{1 + \frac{2}{3 + 4} + 5 \cdot 6 + 7}{8} = \frac{67}{14}
\]  

(2.19)

In order to get that last denominator, we had to select the expression we had entered for the numerator with the mouse, so that the entire contents of the entry rectangle were blue. Then we typed a slash and the denominator appeared beneath it all.

An alternative to using the mouse to enter expression (1.2.1.18) would be to use parentheses. If we type "(1+2/3+4→+5*6+7)/8 enter" we will see this:

\[
\frac{\left(1 + \frac{2}{3 + 4} + 5 \cdot 6 + 7\right)}{8} = \frac{67}{14}
\]  

(2.20)

This allows you to enter complicated expressions without having to use the mouse. Of course, the mouse is still necessary if you want to go back and edit.

We observe in passing that a distinctive feature of Maple is that Maple does exact arithmetic with integers and fractions. It keeps fractions as the ratio of two integers. It will, however, automatically simplify such ratios to lowest terms:

\[
\frac{\frac{2}{3} \cdot \frac{6}{7} - \frac{18}{7}}{\frac{2}{3}} = -2
\]  

(2.21)

**Making typographical mistakes**

Making mistakes is a normal part of using any tool, be it a computer or otherwise. You'll probably make as many mistakes learning how to use Maple as you would make when learning a new sport, a musical instrument, or when learning how to write a good essay. Some of them will be obvious as soon as you make them, others will be subtle or harder to figure out how to fix.

When you make some kinds of mistakes, the computer may give you an error message. For example, if you make a typo and Maple doesn't recognize what you enter as being a valid command, it will complain. Here are some typical error messages. At this stage, some of the messages will make sense and you can react appropriately. Others will use vocabulary that is unfamiliar. For those, the best thing to do is to have a clear idea of what you want to enter (by closely imitating examples that are known to work) and checking carefully that what you have typed was accurate.

**Table 2.6: Examples of Maple error messages**

<table>
<thead>
<tr>
<th>Expression</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 +</td>
<td>Error, invalid sum/difference</td>
</tr>
</tbody>
</table>
We intended to enter "2 + 4" but forgot to type the "4" before we hit enter (return). The appropriate thing to do here is to correct the expression and hit enter again.

\[ 2 + 4 \]

\[ 6 \]  

(2.23)

**+ 2 4**  
Error, missing operation  

\[ +2.4 \]

This time we mistakenly enter the expression with the symbols in the wrong order. Maple complains that it expects some operation to be entered between the two numbers but there isn't one.

\[ . + 4 \]

Error, invalid matrix/vector product  

\[ +4 \]

We intended to enter "2+4" but typed a period instead of a 2 by mistake. Even though we are trying to do the same thing, the error message is different because a different symbol (the period) in this context suggests to Maple that we are trying to do linear algebra. The appropriate thing to do here is to correct the expression and hit enter again.

\[ 2 + 4 \]

\[ 6 \]  

(2.26)

\[ \frac{2}{0} \]

Error, numeric exception: division by zero  

If we ask Maple to do an impossible operation, it sometimes gives an error (depending on the operation). The appropriate question to ask yourself here is "what should I be dividing by instead of zero?".

\[ \frac{3}{5 + 3 \cdot 1} \]

Error, unable to match delimiters  

\[ \frac{3}{5 + 3 \cdot 1} \]

We started a sub-expression with a parentheses but forgot to finish it. In Maple, a delimiter refers to a parenthesis -- ( or ) -- a bracket [ or ], or a brace { or }. Delimiters are symbols that mark the beginning and end of an expression. In many instances they are necessary to unambiguously indicate meaning. For example \[ 5 \cdot (3 + 5) \] evaluates to 40, where as the expression without parentheses \[ 5 \cdot 3 + 5 \] means 20 because multiplications are always done before additions unless the parentheses indicate otherwise.

\[ \left( 3 + \left( 5 + \frac{3}{7} \cdot 5 \right) \right) \cdot 2 \]

Error, unable to match delimiters  

\[ \left( 3 + \left( 5 + \frac{3}{7} \cdot 5 \right) \right) \cdot 2 \]

This is another instance of the same mistake. We wanted to enter \[ \left( 3 + \left( 5 + \frac{3}{7} \right) \cdot 5 \right) \cdot 2 \] but misplaced several parentheses.
We intended to enter "1+3" but typed the extra comma in by mistake. We get an error message that talks about sequences, a concept in Maple that we haven't discussed yet (that's coming in the next few chapters). Maple thinks that the sequence is "invalid" because it usually expects commas to be between items, such as "1,2,x".

Maple's language has many other elements in it that we haven't gotten to discuss yet. If you use any of them by mistake then you will see messages with vocabulary we haven't discussed yet.

It's a fairly typical experience for new users to see some messages that you won't be able to gather much intelligence from other than the fact that you made a mistake that you should fix.. With knowledge-rich systems such as Maple, you may blunder into sections of the system that you haven't learned yet. The best strategy is to back out of the situation by editing the expression so that it is exactly like something that is known to work.

This one is fairly obvious. In order to fix it though, we need to know what denominator we intended to enter.

\[
2 + \frac{9}{3} = 5
\]  

**Correcting typographical mistakes**

The standard procedure for fixing a mistake is as you would in a word processor: *edit the mistaken input* and *re-execute the computation*. Here are ways of doing this:

1. Using the mouse, position the cursor where the mistake is. Then use the backspace key to erase the characters you want to get rid of. Type in more characters to replace it.
2. Use the left arrow key (←) to back up. Typing after backing up then inserts the new typing at the point where the cursor was positioned.
3. Use the mouse or other "pointing device" of your computer to select a section of what you typed. New typing then replaces the selection of what you typed.
4. Use the mouse to select a region, then "cut", which you can do through the Maple menu Edit -> Cut. Of course most people use the keyboard shortcut for cutting, which for Windows or Linux is control-X while on the Mac it's command-X.
5. Copying and pasting (control/command-C and control/command-V) also works in Maple.
You may find that sometimes you attempt to create a 2D Math input area but Maple does not compute a result for the input after you hit the enter key. To create a "clickable math" input area if this happens, place the cursor where you want the input area to be, and use the Format->Create Document Block Menu item of the Maple window:

Table 2.7: Create Document Block to force a Math input area wherever the cursor is placed

![Maple screenshot](image)

Exponentiation (powers). Numbers with lots of digits

Use a caret \(^\) to specify an exponent (a "power"). In math mode, Maple will position the cursor so that the next things you enter will become the exponent. As with fractions, you can get out of the exponent by using the right arrow key \(\rightarrow\) when you want to go back to non-exponent numbers. Try entering these expressions

\[
2^3
\]

\[
\frac{2^{1000} - 2}{2}
\]

\[
53575430359313366047421252453000090528070240585276680372187519418517552556246806;
1246599189407847929063797336458776573412593572642846157021792228878740928740;
1967283887412115492710537302531185570938977091076523237491790970633699383779;
582771973038531457285598238843271083830214915826312193418602834034687
\]

\[
2^{1000} - 2
\]
We note that Maple does integer and fraction operations exactly. It will not introduce any rounding error into a computation as a calculator would when the answer requires more than ten decimal digits to write down.

There are limits to the number of digits Maple will use for integers or fractions, but they have to do more with ultimate limits of the computer hardware and memory rather than a "pre-ordained" decision about how many digits might be useful to keep. If you type kernelopts(maxdigits) into a Math input area on the worksheet, Maple will print out a number which is the maximum number of digits it can handle in any integer or fraction. On the author's computer,

\[
\text{kernelopts(maxdigits)} = 268435448
\]

Note that this is not the value of the maximum number, but how many decimal digits the largest number can have.

For example, Maple can compute the result of

\[
\frac{1}{52!} + \frac{2^{100}}{3^{22}} \text{ exactly (try it!).}
\]

Exact computation is useful not only for doing algebra but also for things such as computing probabilities through counting, or in deriving mathematical formulas for use in simulation or prediction programs.

**Detecting and fixing vocabulary and "logic" mistakes**

There will be other kinds of mistakes where there is no error message, but the response is not what you want. Sometimes this happens because you say something that while grammatical, means something entirely different from what you meant. This could be as simple as entering "2-3" where you meant to type "2+3". Sometimes it is less obvious, such as mistyping the 23-rd digit of a 55 digit number or the 12th term of a long sum. Or worse yet, it could be because you are using the incorrect vocabulary so what you think you are saying does not have that meaning to the computer.

**Table 2.8: Example of a vocabulary mistake**

<table>
<thead>
<tr>
<th>2\times3 + 5</th>
<th>2\times3 + 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 \cdot 3 + 5</td>
<td>2 \times 3 + 5</td>
</tr>
</tbody>
</table>

(2.32)

Suppose we were under the (mistaken) impression could use "x" in Maple to stand for multiplication. We might use the above as a way to calculate "two times three, plus five". However, while there is no error message, what is calculated is not the number we were expecting. The first step towards proceeding to fix this is to realize that it's not what we want. To Maple, this is a legitimate calculation -- you want to create a formula that's "two times the variable x3, plus five".

\[2 \cdot 3 + 5\]

\[11\]

(2.33)

Knowing that the proper way to enter multiplication is through a palette, or symbol "*" (asterisk) as explained in

Finally, there are mistakes made because you ask Maple to do the wrong calculation. Even though Maple does what you want, it turns out that what you wanted was wrong!

For example, you may read a word problem and decide to solve the equation \(3 \cdot x + 2 = 6\), whose solution is \(x = 4/3\). But when you plug the solution into the circumstances of the problem, you find that it doesn't solve the word problem. The problem may be because you used faulty logic to decide that \(3 \cdot x + 2 = 6\) was the equation, but it was actually \(2 \cdot x + 4 = 6\). This is known as an "error in logic" or just a "logic error".
Sometimes it's obvious that you made a mistake because the answer is obviously wrong. For example, seeing "-1" when you are expecting the answer to "2+3" is obvious because you know already that you shouldn't get an answer which is a negative number. Sometimes it isn't so obvious, so you need a way to check the correctness of the result.

2.4 Saving and retrieving your work

You can save your work in a Maple worksheet file through the File -> Save (keyboard shortcut: control/command-S) menu item of the Maple application. A dialog box appears allowing you to type in the name of the worksheet (we've typed in "test" into the box in the .)

The file is saved with a ".mw" suffix (e.g. test1.mw).

To retrieve the file in a subsequent Maple session, start up the Maple application as before and then use the File->Open menu item to initiate the dialog that retrieves the file.

Table 2.9: Maple save menu operation
2.5 Retrieving backups

The "state of Maple" display appears on the bottom left hand side of the Maple window. Usually this display says "Ready", which means that Maple is awaiting your next command. Sometimes it reads "Evaluating..." which indicates that Maple is actively computing an answer. Sometimes it says "Autosaving worksheet", which means that it is saving a copy of the present state of your open worksheets into temporary storage on your computer. The amount of time Maple spends autosaving becomes noticable in longer Maple sessions when the worksheet containsa lot of results.

Should your computer suddenly lose power or should Maple crash, you can retrieve the last autosaved worksheet by selecting the File -> Recent Documents -> Restore Backup menu item. This will fill your Maple with copies of all the autosaved worksheets. You may then delete them or save them to permanent file space as you wish.

Table 2.11: The Maple state display
2.6 Algebra, plotting and mouse-clickable operations

Algebraic expressions and equations. Solving equations. Working with pieces of expressions.

We don't have to limit ourselves to just numerical calculation in Maple (even if the ability to use as many digits as we wish and exact fractions allows us to do arithmetic more like the math books do). Another distinctive feature of Maple is that you can do algebra by entering expressions with symbols -- the $x,y,z,i,$ and $n$ that we see in algebra books. Maple will automatically collect terms and do some simplifications for us automatically

$$x^2 + 2x + 5 + 3x$$

$$x^2 + 5x + 5$$  \hspace{1cm} (2.34)

We can even enter equations:

$$\frac{3}{5}x + 1 = 4 - x$$

$$\frac{3}{5}x + 1 = 4 - x$$  \hspace{1cm} (2.35)

$$3x + 1 + 4x = ax + b$$

$$7x + 1 = ax + b$$  \hspace{1cm} (2.36)

Note that while Maple automatically collected the $x$ terms on the left hand side of the equation, it does not try to do the more interventionist operation of moving all the $x$ terms to the same side of the equation.

Now, enter the following expression, but rather than hitting the enter key after you've entered it, do a right-click. On the Mac, instead of right-clicking hold the control key down then click on the mouse button (this is referred to as "control-click"). A menu of algebraic operations will pop up. Select Factor and see how Maple can factor the polynomial:

$$x^2 + 5x - 50$$

factor

$$(x + 10) (x - 5)$$

Note that this line does not have a (XX) label for it.

To further demonstrate the right-click (control-click) operations available, enter the following equation. Right click on the expression and a pop-up menu should appear that includes a "solve" item. Select the solve and a submenu will appear where you can specify that you want to solve for $x$.

$$\frac{3}{5}x + 1 = 4 - x$$

solve for $x$

$$\left[ \begin{array}{c} x = \frac{15}{8} \\ \end{array} \right]$$
For those with previous experience on other systems: some things are different, for a reason

(This section is for people who already know a programming language and are noticing that Maple does some things differently. Other readers can skip this section.)

Most mainstream programming languages work in a similar way. That is why learning Maple has value beyond just being able to use the Maple system -- once you learn Maple, learning Matlab or Java or C is a matter of incremental adjustment. Noticing the differences is educational in that it makes you become aware of the arbitrariness of some of features of languages. If you have used another programming language such as Java or Visual Basic (VB), you will notice that some things do not work the same in Maple as they do there. Some of this can be explained if you know something about the history of programming languages. Some of it is explained by being aware that the designers of Maple had different goals than those who invented Java or VB.

One thing that you have undoubtedly noted is that symbols do not have to have a value associated with them. For example, in Java if you said

\[ k=5; \]

Then if you were to create another expression in Java such as System.out.println(k^2 + k + 3); then "5" would be used as the value of \( k \) in the expression and you would end up printing 38. In Maple, you do not have to associate \( k \) with a numerical value before you use \( k \) in an algebraic expression. If there is no prior association, Maple just treats the expression as a formula with symbols in it. It may do some algebraic simplification on what you entered, but it does not need to get a number as a result. Since there was no prior assignment for the expressions in section 2.5.1, the calculation done with them just keeps the formula.

Another thing that is different is that in Maple "=" is used for equations, not assignment. The operator in Maple corresponding to "=" in Java or VB is "::=" (a colon immediately followed by an equals, with no spaces inbetween). In Maple, if we wanted to associate "5" with the symbol \( k \), then we would do:

\[
\begin{align*}
\text{k := 5} \\
k^2 + k + 3 + k
\end{align*}
\]

\[ 38 \]  

(2.38)

People who know more than one programming language have a better understanding of which features are change a lot between languages, (such as whether "=" or "::=" is used for assignment), and which ones are fairly uniform (+ being used for addition, or the use of parentheses in functions and expressions).

Maple does not use "=" for assignment because, being a mathematically oriented language that can handle algebra, it wants to make the entry of equations a natural thing. Its use of "=" for assignment is a feature borrowed from the Algol/Algol 68/Pascal family of programming languages, which picked this operator to make it clear that the assignment operation is different from algebraic equality. Is "=" better than "::="? That's a kind of question that is about as hard to answer as trying to decide whether "uno" is better than "one". If one had a language where you had to do "=" instead of "=" or "::="; you could be critical of the choice because it takes much more effort to enter a 35 character operator than a one or two character one. But the Algol-family choice of "=" has reasonable motivation -- studies of novice programmers have shown that beginners using languages where "=" is the assignment make more mistakes because they confuse its use in mathematics with its use in programming. Novices have been observed to write things like "5=k" which does not work as an assignment, even though mathematically the equations "k=5" and "5=k" mean the same thing.

Just as with architectural design of a building, each feature of a programming language is typically carefully considered. Many features are borrowed or copied from predecessor languages, where they have already been subjected to the test of many people using the feature. If you are not familiar with Algol family languages, you can see examples of them at various educational web sites, such as http://www.engin.umich.edu/CfIS/course.des/cis400/algol/average.html and http://portal.acm.org/citation.cfm?id=154766.155365.
Plotting and approximate numerical solutions

The right-clickable interface can also activate a plot of a formula you may have entered. Enter this formula, then right-click and select Plot ->2d plot. The automatic defaults for plotting this produce this result.

Table 2.12: Example of Plotting

\[ x^2 - 10x + 4 \]
Table 2.13: Plot created by right-click -> Plot -> 2DPlot

User has clicked on the plot and positioned the cursor at the coordinate (-4.12, 61.60). The cursor was not captured by the screenshot although it is visible under ordinary use.

The 2DPlot operation makes pre-set decisions about the plot, such as the range of $x$ (-10 to 10), the color of the line, axes labelling, etc. Users can inject their own preferences about these things about this by selecting right-click -> Plot -> PlotBuilder and filling in the dialog box with their choices.

Table 2.14: User-configured plot using PlotBuilder instead of 2DPlot

\[ x^2 - 10 \cdot x + 4 \rightarrow \]
The Expressions Palette and the Common Symbols Palette: entering Trigs, logs, roots, exponentials

It's possible to get the common functions of high school algebra, pre-calculus, and calculus by using the Expression palette of the Maple Window:

Table 2.15: The Expression palette
For example, to enter the square root of 36, click on the palette entry for $\sqrt{a}$. That expression will appear in the document, with the "a" selected. If you then type 36 on the keyboard, that number will replace the selected text. If you then hit the enter key, Maple will evaluate the expression and produce the exact result "6".

$$x + y + \frac{1}{2} + \frac{1}{4} + \sqrt{36}$$

$$x + y + \frac{27}{4}$$ (2.39)

You can use the palette multiple times, to create more complicated expressions. Just continue to the use mouse or the arrow keys to move around in the expression. Selecting and typing, backspacing or deleting are all ways of replacing or correcting pieces of the expression.

The Common symbols palette, two panels below the Expression palette, can be used to enter $\pi$ and $e$, the base of the natural logarithm system.

The palette does not have the inverse trig functions, so you have to enter them through typing. Their names are: arcsin, arccos, arctan, etc.
Table 2.16: Examples of palette-driven computation

\[
\begin{align*}
\sin\left(\frac{\pi}{4}\right) + \cos\left(\frac{\pi}{4}\right) & = \sqrt{2} \\
\left(\sqrt{1024} + \ln\left(e^3\right)\right) / 13 & = \frac{98}{39}\pi \\
\arcsin\left(\sin\left(\frac{1}{4}\pi\right)\right) & = \frac{1}{4}\pi
\end{align*}
\]

(2.40) (2.41) (2.42)

**Approximate numerical (calculator - type) arithmetic in Maple**

If you enter expressions with integers, exact fractions, and symbols such as \(\pi\) and \(e\), then Maple will perform exact calculations rather than give approximate answers as a conventional calculator would. You can get approximations by selecting the "numerically solve" instead of the "solve" option from the right-click pop-up menu.

Table 2.17: Examples of computing with approximate solving

\[
\begin{align*}
x^2 - 10x + 4 & = x^2 - 10x + 4 \\
\text{solve} & \rightarrow \{x = 5 + \sqrt{21}\}, \{x = 5 - \sqrt{21}\}
\end{align*}
\]

Exact solution of an equation using the "solve" feature of the pop-up menu.

\[
\begin{align*}
x^2 - 10x + 4 & = x^2 - 10x + 4 \\
\text{solve} & \rightarrow 0.4174243050, 9.582575695
\end{align*}
\]

Using the "numerically solve" feature of the pop-up menu

If you have an exact expression, you can ask Maple to approximate it to 5, 10, 20, or more digits. In this mode, Maple can be used as a super-accurate calculator.

**Examples of numerical computation**

1. Enter fraction, select approximate->20 from right-click pop-up menu.
\[
\frac{47}{52} + \frac{4}{3}
\]

\[\text{at 20 digits}\]

\[2.2371794871794871795\]

2. Enter exact expression, select approximate-\(\Rightarrow 5\) from right click pop-up menu

\[\sin\left(\frac{\pi}{10}\right)\]

\[\text{at 5 digits}\]

\[0.30902\]

3. Enter equation. Then solve-\(\Rightarrow\)solve, then select Element-\(\Rightarrow 1\), then right hand side, then approximate-\(\Rightarrow 10\)

\[\sin\left(\sqrt{e^x}\right) = \frac{1}{3}\]

solve

\[x = 2 \ln\left(\arcsin\left(\frac{1}{3}\right)\right)\]

select entry 1

\[x = 2 \ln\left(\arcsin\left(\frac{1}{3}\right)\right)\]

right hand side

\[2 \ln\left(\arcsin\left(\frac{1}{3}\right)\right)\]

\[\text{at 10 digits}\]

\[-2.158578910\]

**Evaluation, and selection of pieces.**

Sometimes you wish to evaluate an expression for a particular value of a variable. There is a right-click operation that does this.

**Table 2.18: Evaluate at a point**

<table>
<thead>
<tr>
<th>Expression</th>
<th>This operation will give a pop-up menu that will allow us to choose values for all the variables. In the first example, we picked 1/2 for a value of x. Note that the pop-up menu will show what you typed rather than displaying 2D</th>
</tr>
</thead>
<tbody>
<tr>
<td>(x^2 - 2\cdot\alpha\cdot x = 0)</td>
<td>evaluate at point</td>
</tr>
</tbody>
</table>
Using the right-click menu, it's possible to select or extract a portion of an expression for further work.

**Table 2.19: Operations on equations, multi-part expressions**

<table>
<thead>
<tr>
<th>Operation</th>
<th>Example</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>right hand side, left hand side</td>
<td>$x = \frac{\sin(a)}{r^2 - 1}$</td>
<td>One of the options in the right-click menu is &quot;right hand side&quot;. It only works for equations.</td>
</tr>
<tr>
<td>Operations on multi-part expressions</td>
<td>$x^2 - 4 \cdot x = 4$</td>
<td>Solving this quadratic equation reveals that there are two solutions. Right-clicking on the solution and then selecting entry 1 gives the first solution, enclosed in brackets [ ]. Right-clicking on that and again selecting entry 1 gives the first solution, without the brackets. Right-clicking on that and selecting approximation gives a calculator approximation to the root.</td>
</tr>
</tbody>
</table>

2.7 A quick-reference summary to this chapter

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arithmetic</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$2 + \frac{3^2}{4} - \frac{1}{6}$</td>
<td>Use $\times$, $\div$, $\sqrt{}$, $^\wedge$ for arithmetic. Hitting the Enter key produces a labelled result.</td>
<td>2 D Math input mode displays the textbook-like version of what you input. Maple's simplification automatically combined fractions and places things in lowest terms.</td>
</tr>
<tr>
<td>$\frac{49}{12}$ (2.43)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Making mistakes</strong></td>
<td>Error message mistakes (from typos or mistakes in intensions)</td>
<td>The easiest ones to detect. You have to figure out what you are doing wrong, though. The error message may not always be helpful in advising you on this, although it often is.</td>
</tr>
<tr>
<td>$2 + \left(\frac{3}{5}\right)$</td>
<td>Error, unable to match delimiters</td>
<td></td>
</tr>
<tr>
<td>A farmer plants a fence post every foot, for 1250 feet. At that point, he switches to planting the fence posts every 4.7 feet for another 940 feet. How many fence posts does he need in all?</td>
<td>&quot;Logic errors&quot;</td>
<td>You are asking Maple to compute something that it understands, so it gives you an answer. However, this answer doesn't really solve your problem. You need to find a more appropriate computation, which you can only do by thinking about whether you are asking the computer to do something different from what is needed. Often you can find these kinds of mistakes by looking at simpler versions of the problem where the answer can be figured out with paper and pencil. Then you can &quot;scale up&quot; the answer to handle the actual problem you have. The correct answer is 1251 + 201 1452 fence posts. The computer did what it was asked to do -- the problem was that it was asked to do the wrong thing.</td>
</tr>
<tr>
<td>$\frac{1250}{1} + \frac{940}{4.7}$</td>
<td>Maple did do the arithmetic in the above calculation correctly. The problem is that it's the wrong calculation. Do you see how to get the right answer?</td>
<td></td>
</tr>
<tr>
<td>$\frac{1450.000000}{1}$ (2.45)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Editing (fixing mistakes)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>backspace, delete erase starting from current cursor selection</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Arrow keys $\leftarrow \rightarrow \uparrow \downarrow$ move cursor within current selection</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select with mouse/type replaces selected text</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cut, copy and paste of a selection works as it does with a text processor</td>
<td></td>
</tr>
<tr>
<td><strong>File saves, opens</strong></td>
<td>Save files with File $\rightarrow$ Save or File $\rightarrow$ Save As. Open a saved file with File $\rightarrow$ Open. Other File</td>
<td></td>
</tr>
</tbody>
</table>
### Functions and math symbols

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[3 \sqrt{\csc \left( \frac{\pi}{2} \right)} + e]</td>
<td>Insert math into an expression by using the Expression Palette. You can enter ( \pi ) using the Common Symbols Palette. ( e ) (the natural logarithm base) can also be entered this way. Note: typing ( e ) from the keyboard does not enter this symbol.</td>
</tr>
<tr>
<td>( \ln(e^2 \cdot \sqrt{e}) )</td>
<td>If you are entering a function by the keyboard rather than the palette, you must enclose the function's argument in parentheses.</td>
</tr>
</tbody>
</table>

### Algebra

<table>
<thead>
<tr>
<th>Equation</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>( x^2 - 2x - 15 = 0 )</td>
<td>Right-click (control-click on Mac) on an entered expression to get the pop-up menu.</td>
</tr>
<tr>
<td>( x^2 - 2x - 15 )</td>
<td>Chapter 2 demonstrated examples of the following operations:</td>
</tr>
</tbody>
</table>

### Plotting

<table>
<thead>
<tr>
<th>Plot type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2d plot</td>
<td>The expression must be something that involves a single variable and will result in a number when a value is used for that variable. Thus you can't do a 2d plot of ( x^2 - a ) because you</td>
</tr>
</tbody>
</table>
wouldn't get a number if you picked a value just for x (or just for a).

Maple uses defaults for the plot range, and the plot color.

Trying to plot an equation produces an implicit plot (see next appendix).

Plots->plot builder -> 2d plot

\[ x^2 - 1 \]

A dialog box appears that allows you the select from many more options, such as plot color, the line style, vertical and horizontal ranges, captions, etc.

Limited precision (decimal point) numbers

\[
\cos(x^2) = \sqrt{x} \\
\text{solve}\rightarrow 0.7352027350 \\
0.7 + \frac{2}{3} + \tan(1) + \pi^e \\
0.7666666667 + \tan(1) + \pi^e (2.47) \\
\text{at 20 digits} \\
2.3240743913549022305 + 3.1415926535897932385 (2.48)
\]

Exact numbers in Maple have no decimal points.

Symbolic constants such as \( \pi \) and \( e \) entered from the Common Symbols Palette are also exact.

Numbers with decimal points in Maple cause arithmetic calculations to be done approximately.

solve->numerically solve produces approximate solutions

.right-click->approximate->\( \pi \) takes an exact numerical expression and approximates it.

Use of limited precision numbers in algebra (e.g. factoring, differentiation, solving) may not produce good results.

Use them in Maple only when an approximate result is desired.

Numbers like .25 or .6015 are limited precision. If you want exact algebra done, use 1/4 or 6015/10000, etc.

In very large calculations, limited precision calculations may be noticeably faster than those with exact arithmetic. Most of the time there isn't an appreciable difference.
<table>
<thead>
<tr>
<th>Evaluate at a point</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x^2 - 2\cdot a\cdot x = 0$</td>
<td>evaluate at point</td>
<td>$\frac{1}{4} - a = 0$</td>
</tr>
<tr>
<td>$x^2 - 2\cdot a\cdot x = 0$</td>
<td>evaluate at point</td>
<td>$x^2 - 6y^2\cdot x = 0$</td>
</tr>
<tr>
<td>$3\cdot y + 5$</td>
<td>evaluate at point</td>
<td>14</td>
</tr>
</tbody>
</table>

This operation will give a pop-up menu that will allow us to choose values for all the variables. In the first example, we picked 1/2 for a value of x. Note that the pop-up menu will show what you typed rather than displaying 2D math. In the second example, we specified "3*y^2" as the value for a. In the third example, we picked 3 as the value for y.

<table>
<thead>
<tr>
<th>Operations on equations</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>right hand side, left hand side</td>
<td>$x = \frac{\sin(a)}{r^2 - 1}$</td>
<td>right hand side</td>
</tr>
</tbody>
</table>
| $x = \frac{\sin(a)}{r^2 - 1}$ | left hand side | $x$ | One of the options in the right-click menu is "right hand side". It only works for equations.

<table>
<thead>
<tr>
<th>Operations on multi-part expressions</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>select entry</td>
<td>$x^2 - 4\cdot x = 4$</td>
<td>solve for $x$</td>
</tr>
<tr>
<td>$x^2 - 4\cdot x = 4$</td>
<td>select entry 1</td>
<td>$[x = 2 + 2\sqrt{2}]$</td>
</tr>
<tr>
<td></td>
<td>select entry 1</td>
<td>Solving this quadratic equation reveals that there are two solutions. Right clicking on these selections and then select entry -&gt; 1 produces the first solution. We can then approximate it by using the</td>
</tr>
</tbody>
</table>
### Enter an expression in a document, then right-click (control-click on Mac) followed by:  

<table>
<thead>
<tr>
<th>Operations on symbolic expressions</th>
<th>Example</th>
<th>Commentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>solve-&gt;solve</td>
<td>$x^2 - 1$</td>
<td>{x = 1}, {x = -1}</td>
</tr>
<tr>
<td>solve-&gt;solve for a variable</td>
<td>$x^2 - 2a \cdot x = 0$</td>
<td>$[[x = 0], [x = 2a]]$</td>
</tr>
<tr>
<td>solve-&gt;numerically solve</td>
<td>$x = \cos(x)$</td>
<td>0.7390851332</td>
</tr>
<tr>
<td>Factoring</td>
<td>$x^2 - 1$</td>
<td>Factoring can simplify an expression sometimes. Factoring doesn't know the trig simplification rules, though.</td>
</tr>
<tr>
<td></td>
<td>$\cos(x)^2 - \sin(x)^2$</td>
<td></td>
</tr>
<tr>
<td>Plots-&gt;2d plot</td>
<td>$x^2 - 1$</td>
<td>The expression must be something that involves a single variable and will result in a number when a value is used for that variable. Thus you can't do a 2d plot of $x^2 - a$ because you</td>
</tr>
</tbody>
</table>

$x = 2 + 2\sqrt{2}$ at 5 digits $x = 4.8284$
Operations on equations

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>$x = \frac{\sin(a)}{r^2 - 1}$</td>
</tr>
</tbody>
</table>

Maple uses defaults for the plot range, and the plot color.
\[ x = \frac{\sin(\alpha)}{r^2 - 1} \]

\[ \text{left hand side} \]

\[ x \]

move to right, move to left

\[ x^2 + x + 1 = a \]

\[ 0 = a - x^2 - x - 1 \]

This moves the entire side of an equation to the other side.

<table>
<thead>
<tr>
<th>Operations on constant expressions</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>approximate-&gt;5 (or 10, 20, 50)</td>
<td>[ \tan\left(\frac{\pi}{10}\right) \cdot \sqrt{\frac{1}{e^{10}}} ] at 20 digits [ 0.34157868529293212152 ] [ x = \ln(5000!) ] at 20 digits [ x = 37591.143508876766569 ]</td>
</tr>
</tbody>
</table>